
用户指南和产品规范

NI USB-9234
4 通道， ±5 V， 24 位软件可选 IEPE 和 AC/DC 模拟输入模块

本用户指南主要介绍 NI USB-9234 的使用方法，及其产品规范和连接器分

配。

说明

NI USB-9234 包含 2 个组件：NI 9234 模块和 NI USB-9162 外盒，如图 1 所

示。

图 1 NI USB-9234 组件

NI 9234

NI USB-9162

NI USB-9234

HI-Speed USB Carrier

NI USB-9162

Hi-Speed USB Carrier

NI USB-9162
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尺寸

图 2 为 NI USB-9234 设备的尺寸视图。

图 2 NI USB-9234 设备，以毫米 （英寸）为单位

安全守则

请遵循 NI USB-9234 的使用说明。

注 尽管 NI 9234 模块具有较高的认证标准，当它与 NI USB-9162 外盒配合使用时，系统

满足的标准受各组件限制。 详细信息见产品规范。

注意 该符号表明组件表面温度较高， 触摸该组件可能导致受伤。

注意 电源未断开或处于非安全环境时，请勿断开 I/O 连线或连接器。

注意 电源未断开或处于非安全环境时，请勿卸除模块。

注意 NI USB-9234 未通过用于危险环境的认证。

Hi-Speed USB Carrier
NI USB-9162

140.66 mm
(5.538 in.)

138.30 mm
(5.445 in.)

120.68 mm
(4.751 in.)

118.26 mm
(4.656 in.)

88.12 mm
(3.469 in.)

25.34 mm
(0.998 in.)
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危险电压安全守则
如连接危险电压至模块，需采取下列防护措施。 危险电压是指峰值电压高于

42.4 Vpk 的交流电压或高于 60 VDC 的直流电压。

注意 确保危险电压的连接由具有当地电气安全资质的专业人士完成。

注意 请勿将危险电压电路和人体可接触电路放置在同一模块内。

注意 确保连接至模块的设备和电路与人体接触有效隔离。

相关文档

每套应用软件包和驱动程序都包括完成测量和控制测量设备的编程信息。 
下列参考文档假定用户已安装 NI-DAQmx 8.8 或更高版本，如使用 NI 应用

软件，其版本应为 7.1 或更高。

用于 Windows 平台的 NI-DAQmx
DAQ 入门指南主要介绍在 Windows 平台安装 NI-DAQmx 和相应 DAQ
设备的方法，以及判断设备工作状态的方法。 点击开始 » 程序 »National 
Instruments»NI-DAQ»DAQ 入门指南查看文档。

NI-DAQ 自述文件列出了此版本的 NI-DAQmx 支持的设备信息。 点击开始 »
程序 »National Instruments»NI-DAQ»NI-DAQ 自述文件查看文档。

NI-DAQmx 帮助主要介绍测量概念、 NI-DAQmx 重要概念以及适用于所有

编程环境的常见应用程序。 点击开始 » 程序 »National Instruments»
NI-DAQ»NI-DAQmx 帮助查看文档。

LabVIEW
新用户可通过 LabVIEW 入门指南熟悉 LabVIEW 图形化编程环境，掌握

LabVIEW 创建数据采集和仪器控制应用程序的基本特性。 点击开始 » 程序 »
National Instruments»LabVIEW»LabVIEW 帮助查看 LabVIEW 入门指

南，或访问 labview\manuals路径下的 LV_Getting_Started.pdf。

在 LabVIEW 中点击帮助 »LabVIEW 帮助，通过 LabVIEW 帮助熟悉

LabVIEW 编程理论、编程分步指导以及 VI、函数、选板、菜单和工具的相

关信息。 关于 NI-DAQmx 的详细信息，见 LabVIEW 帮助目录的下列主题：

• Labview入门指南»DAQ入门指南－包括软件概述和使用DAQ助手在

LabVIEW 中进行 NI-DAQmx 测量的教程。 

• VI和函数»测量 I/O VI和函数－主要介绍LabVIEW NI-DAQmx VI和属

性。

• 仪器测量－主要介绍在 LabVIEW 中采集和分析测量数据的概念及详

解，包括常见测量、测量基础、 NI-DAQmx 重要概念和设备信息。
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LabWindows/CVI
LabWindows/CVI Help 中的 Data Acquisition 一章介绍了 NI-DAQmx
测量概念， 其中 Taking an NI-DAQmx Measurement in 
LabWindows/CVI 主题包括使用 DAQ 助手创建测量任务的分步指导。 
在 LabWindows™/CVI™ 中，点击 Help»Contents, 点击 Using 
LabWindows/CVI»Data Acquisition 查看文档。

LabWindows/CVI Help 中的 NI-DAQmx Library 一章介绍了API 概述和

NI-DAQmx 函数。 点击 LabWindows/CVI Help 中的 Library Reference»
NI-DAQmx Library 查看文档。

Measurement Studio
如在 Measurement Studio 中使用 Visual C++、 Visual C#、

Visual Basic .NET 对 NI-DAQmx 支持的设备编程，可在 MAX 或

Visual Studio .NET 中打开 DAQ 助手，交互式地创建通道和任务。 在
Measurement Studio 中，可根据任务或通道生成配置代码。 关于生成

代码的详细信息，见 DAQ 助手帮助。 或者在应用程序开发环境 (ADE) 中
使用 NI-DAQmx API 创建通道和任务。

关于 NI-DAQmx 方法和属性的帮助，见 NI Measurement Studio Help
中的 NI-DAQmx .NET Class Library 或 NI-DAQmx Visual C++ Class 
Library。 关于在 Measurement Studio 中编程的常见帮助，见

NI Measurement Studio Help，该帮助文件在 Microsoft Visual 
Studio .NET 帮助系统中。 要在 Visual Studio. NET 下查看帮助文件， 点击

Measurement Studio»NI Measurement Studio Help 查看文档。

按照下列步骤在 Visual C++、Visual C#或Visual Basic .NET中创建应用程序：

1. 在 Visual Studio .NET 中，点击 File»New»Project 打开 “New 
Project” 对话框。

2. 查找创建程序所在语言区域的 Measurement Studio 文件夹。

3. 选择一个项目类型。 添加 DAQ 任务，作为步骤的一部分。

ANSI C，未安装 NI 应用软件
NI-DAQmx 帮助包括 API 概述和基本测量概念。 点击开始 » 程序 »
National Instruments»NI-DAQ»NI-DAQmx 帮助查看文档。

NI-DAQmx C Reference Help 主要介绍 NI-DAQmx 库函数，可配合 NI
数据采集设备开发虚拟仪器、数据采集和设备控制应用程序。 点击开始 »
程序 »National Instruments»NI-DAQ»NI-DAQmx C Reference Help
查看文档。
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.NET 语言，未安装 NI 应用软件
如已安装 Microsoft .NET Framework 1.1 或更高版本，可直接在

Visual C# 和 Visual Basic .NET 平台通过 NI-DAQmx 创建应用程序，无

需 Measurement Studio。 如要安装 API 说明文档，需安装 Microsoft 
Visual Studio .NET 2003 或 Microsoft Visual Studio 2005。

安装的说明文档包括 NI-DAQmx API 概述、测量任务和概念，以及函数参

考。 该帮助文件完全集成在 Visual Studio .NET 文档中。 通过开始 » 程序 »
National Instruments»NI-DAQ»NI-DAQmx .NET Reference Help 可查

看 NI-DAQmx .NET 文档。 展开 NI Measurement Studio Help»
NI Measurement Studio .NET Class Library»Reference 可查看函数参

考信息。 展开 NI Measurement Studio Help»NI Measurement 
Studio .NET Class Library»Using the Measurement Studio .NET Class 

Libraries 可查看 NI-DAQmx 与 Visual C# 和 Visual Basic .NET 配合使用

的相关主题。

如需在 Visual Studio 中查看同一帮助主题，点击 Help»Contents， 从
Filtered By 下拉列表中选择 Measurement Studio，然后按照上述要求操

作。

设备文档和产品规范
NI-DAQmx 支持的设备和附件文档（包括介绍设备端子说明、产品规范、

功能和使用说明的 PDF 文档和帮助文件）位于包含设备说明文档的

NI-DAQmx 光盘上。 插入光盘，打开 Device Documentation 目录，

双击相应语言的 Device Documents 快捷方式，可查看或打印设备文档。

注 用户也可登录 ni.com/manuals下载文档。

培训课程
为满足客户使用 NI 产品开发应用程序时的帮助需求， NI 提供相应的培训课

程。 请登录 ni.com/training，报名参加培训，获取详细课程资料。

网络技术支持
登录 ni.com/support或 zone.ni.com可获取更多技术支持。
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软件安装

NI-DAQmx 可为 NI USB-9234 提供适用于 Windows Vista/XP/2000 平台

的软件支持。 DAQ 入门指南为 NI-DAQmx 用户提供软件 / 硬件安装、配

置通道 / 任务的分步指导和开发应用程序入门。登录 ni.com/manuals可

下载该文档。

安装其他软件
如需使用其他软件，见软件随附安装说明。

程序范例
NI-DAQmx 光盘中带有程序范例，用户可使用这些程序范例尝试对

NI USB-9234 编程。相关信息见设备随附的 NI-DAQmx 在 USB 设备上的应

用－入门指南，或通过开始 » 程序 »National Instruments»NI-DAQ 查看

文档。

安装 NI USB-9234 设备

安装硬件设备前，需安装与设备配合使用的软件。 详细信息见文档的软件安

装部分及软件相关文档。

安装 NI 9234 至 NI USB-9162 外盒
NI 9234 模块和 NI USB-9162 外盒均为独立包装。 请参照图 3 完成安装步骤：

1. 确保 NI 9234 模块未连接信号或 USB 线缆。

2. 移开 15 针 D-SUB 连接器的保护盖。

3. 如图 3 所示，对齐 I/O 模块和外盒。

图 3 模块安装

 Hi-Speed USB Carrier

NI USB-9162
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4. 挤压卡锁，将 NI 9234 模块插入 NI USB-9162 外盒。

5. 如图 4 所示，用力按压 NI 9234 模块与外盒的连接部分，直至模块固

定到位。

图 4 锁定模块

固定 NI USB-9234
NI USB-9234 表面带有内嵌螺纹孔，用于设备与面板间固定。 图 5 为模块尺

寸视图。

图 5 模块尺寸视图

连接 NI USB-9234 至计算机
USB 线缆一端连接 NI USB-9234，另一端连接计算机的可用 USB 端口。 详
细信息见设备随附的 NI-DAQmx 在 USB 设备上的应用－入门指南，或通过

开始 » 程序 »National Instruments»NI-DAQ 查看该文档。

 
Hi-Speed USB Carrier

NI USB-9162

M3 x 0.5
8.5 mm (0.34 in.)

72.2 mm
(2.84 in.)

85.7 mm
(3.37 in.)

76.1 mm
(3.00 in.)
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LED 指示灯
NI USB-9234 设备的 USB 连接器附近有一个绿色 LED 指示灯。 如表 1 所

示， LED 指示灯用于显示设备状态。 设备连至 USB 端口时， LED 指示灯将

有节奏地闪烁。表明设备正在初始化且 USB 端口为设备供电。

设备指示灯未闪烁的情况下，请确认计算机已安装最新版本的 NI-DAQmx，
且计算机未处于待机模式。

连接 NI USB-9234
NI USB-9234 共有四个 BNC 连接器，可提供四路同步采样模拟输入通道的

连接。 每个通道均带有一个可连接信号源的 BNC 连接器。 用户也可启用通

道激励电流，以连接 IEPE 传感器。 连接器中央的引脚 AI+ 提供直流信号连

接。 连接器的外壳 AI– 提供激励返回路径和交流信号接地参考。 图 6 为每

个通道的连接器分配示意图。

图 6 NI USB-9234 连接器分配

表 1 LED 状态 / 设备状态

LED 状态 设备状态

不亮 未连接设备或计算机处于暂停模式。

亮，不闪烁 设备已连接，未安装模块。

单闪 正常工作。

双闪 连至 USB 全速端口。 设备性能可能受到影响。 详细信息见产品规范一节。

闪烁 4 次 设备出错。 请访问 ni.com/support获取帮助。

AI3+
AI3–

AI2+
AI2–

AI0+
AI0–

AI1+
AI1–
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连接信号源至 NI USB-9234
NI USB-9234 可连接接地或浮接信号传感器，使用浮接可避免对地噪声。 避
免 BNC 连接器的金属外壳之间、及其与模块或机箱的接触，可进一步降低

地噪声。

如 NI USB-9234 与信号源为接地连接，需确保 AI– 外壳电压位于共模电压

范围内，NI USB-9234 才能正常工作。在过压保护范围内，可防止 AI– 外壳

电压意外达到过高电压。 关于工作电压和过压保护的详细信息见产品规范。 

图 7 和图 8 分别为接地和浮接的信号源与 NI USB-9234 的连接示意图。

图 7 连接接地 IEPE 传感器至 NI USB-9234

图 8 连接浮接 IEPE 传感器至 NI USB-9234

NI USB-9234 可为用于测量的接地或浮接 IEPE 传感器提供 IEPE 激励电流。 
典型 IEPE 传感器外壳与 IEPE 器件之间是电气隔离的，因此即使传感器外壳

接地， NI USB-9234 与传感器的连接仍为浮接。

NI USB-9234

AI+

AI–

+

–

NI USB-9234

AI+

AI–

+

–
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NI USB-9234 的电路

NI USB-9234 模拟输入通道通过一个 50 Ω的电阻连接至机箱地。 如要最小化

对地噪声，应确保机箱接地。 每个通道均具有过压保护功能。 NI USB-9234
的每条通道可被配置为 AC 或 DC 耦合。 在 AC 耦合模式（软件）下，可打

开或关闭 IEPE 激励电流。 DC 耦合模式下，IEPE 电流不可用。 每个通道的输

入信号经缓冲、调理后，由 24 位 Delta-Sigma 模数转换器对其采样。

图 9 某一通道的输入电路

未启用 IEPE 电流时， NI USB-9234 使用共模偏置电流偏置限流二极管。 
使用接地信号源时，该电流会产生由 AI– 导线电阻引起的误差。 误差约为

（50 ppm 量程 +15 ppm 读数） /AI– 阻抗 (Ω)。 此共模偏置电流误差仅发

生在使用接地信号源时，使用浮接信号源无需考虑此误差。 为获得最佳精

度，请采用浮接方式或使用低阻抗导线连接接地信号源。

图 10 共模偏置电流导致的测量误差

NI USB-9234 带有 TEDS 电路。 关于 TEDS 的详细信息，请访问 ni.com/
info，输入信息代码 rdteds查询。

2 mA IEPE

AI+

AI– ADC
+

–

AC/DC

NI USB-9234

50 Ω

NI USB-9234AI+

AI–

+

–
AI–
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NI USB-9234 滤波
通过模拟滤波和数字滤波，NI USB-9234 可精确表示带内信号并抑制带外信

号。 滤波器根据信号的频率范围 （带宽）区分信号。 三个需考虑的重要带

宽因素分别为：通带、阻带和无混叠带宽。

NI USB-9234 主要通过通带平滑度和相位非线性度定量表示通带内信号。 滤
波器可最大程度地抑制阻带内频率，即阻带抑制。 无混叠带宽范围内的所有

信号均为无混叠信号或至少经阻带抑制过滤的信号。

通带
通带内信号的增益和衰减是基于频率变化的。 通带平坦度是指相对于某频率

范围，增益的变化幅度非常小。 NI USB-9234 使用数字滤波器调整通带频率

范围，使其与采样率匹配。 因此，给定频率下的增益和衰减取决于采样率。 
图 11 为 51.2 kS/s 采样率下的典型通带平坦度。

图 11 NI USB-9234 的典型通带响应

阻带
滤波器将显著减弱所有高于阻带频率的信号。 主要目的是防止产生混叠。 因
此，阻带频率与采样率之间存在精确的比例关系。 阻带抑制是滤波器对阻带

内所有频率信号应用的最小衰减值。

无混叠带宽
NI USB-9234 无混叠带宽范围内的信号不是高频信号的混叠。 无混叠带宽是

由滤波器抑制高于阻带频率信号的能力定义的，无混叠带宽等于采样频率减

去阻带频率。

(kHz)
302520

0.025

0.000

–0.025

–0.050
151050

(d
B

)
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NI USB-9234 的采样率

NI USB-9234 的采样率 (fs) 取决于主时基频率 (fM)。NI USB-9234 内部带有

一个频率为 13.1072 MHz 的主时基，但模块也可使用外部主时基或输出主

时基。 关于配置 NI USB-9234 主时基源的详细信息，见软件帮助文档。 

可根据下列公式计算 NI USB-9234 的可用采样率：

fs = 

其中 n 表示 1 ～ 31 之间的任意整数。

采样率必须位于采样率范围内。 关于采样率范围的详细信息见产品规范。 
使用 13.1072 MHz 内部主时基时，采样率可为 51.2 kS/s、 25.6 kS/s、
17.067 kS/s……1.652 kS/s，实际值取决于 n。 使用外部时基

（非 13.1072 MHz）时， NI USB-9234 具有不同的采样率取值。

产品规范

除非另外声明，否则下列规范的适用温度范围为 0 °C ～ 60 °C。

输入特性
通道数 ................................................................. 4 个模拟输入通道

ADC 分辨率...................................................... 24 位

ADC 类型 ..........................................................Delta-Sigma （带模拟预滤波）

采样模式.............................................................  同步

支持的 TEDS 类型 ............................................  IEEE.1451.4 TEDS Class I
（接口）

内部主时基 （fM）

频率............................................................. 13.1072 MHz
精度............................................................. ±50 ppm，最大值

使用内部主时基时的采样率范围 (fs)
最小值 ........................................................ 1.652 kS/s
最大值 ........................................................ 51.2 kS/s

使用外部主时基时的采样率范围 （fs）

最小值 ........................................................ 0.391 kS/s
最大值 ........................................................ 52.734 kS/s

采样率 （fs）......................................................  , n = 1， 2, ……, 31

f M  256
n

-------------------------

f M 256
n

--------------------
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输入耦合 ............................................................ AC/DC （软件可选）

交流截止频率

–3 dB ......................................................... 0.5 Hz，常规值

–0.1 dB...................................................... 4.6 Hz，最大值

交流截止频率响应 

输入范围 ............................................................ ±5 V

交流电压全量程

最小值 ........................................................ ±5 Vpk

常规值 ........................................................ ±5.1 Vpk

最大值 ........................................................ ±5.2 Vpk

共模电压
（AI– －地）....................................................... ±2 V，最大值

IEPE 激励电流（软件可选开 / 关）

最小值 ........................................................ 2.0 mA
常规值 ........................................................ 2.1 mA

上电情况下毛刺 ............................................... 90 mA, 10 ms

IEPE 兼容电压................................................... 19 V，最大值

104

0.5

0.0

–0.5

–1.0
3210 98765
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使用 IEPE 传感器时，请使用下列公式确定配置是否符合 IEPE 兼容电压范

围。

Vcommon-mode + Vbias + Vfull-scale 的值必须位于 0 ～ 19 之间

 

过压保护 （相对于机箱地）

连接至 AI+ 和 AI– 的信号源 ................ ±30 V
连接至 AI+ 和 AI– 的低阻抗源 ............  –6 V ～ 30 V

输入延迟............................................................. 3.2 ms + 38.4 fs

精度1

增益漂移

常规值 ........................................................ 0.14 mdB/°C (16 ppm/°C)
最大值 ........................................................ 0.45 mdB/°C (52 ppm/°C)

电压漂移

常规值 ........................................................ 19.2 mV/°C
最大值 ........................................................ 118 mV/°C

通道间匹配

增益

常规值................................................ 0.01 dB
最大值................................................ 0.04 dB

相位 （fin，以 kHz 为单位）................  fin · 0.045° + 0.04，最大值

其中 Vcommon-mode 为加至 NI USB-9234 的共模电压。

Vbias 为 IEPE 传感器的偏置电压。

Vfull-scale 为 IEPE 的全量程电压。

1   关于接地信号源和测量精度的详细信息见 NI USB-9234 的电路。

测量条件 读数百分比 （增益误差） 量程百分比 * （偏置误差）

已校准，最大值

(–40 °C ～ 70 °C)
0.34%, 

±0.03 dB
±0.14%, 
7.1 mV

已校准，常规值
(25 °C ±5 °C)

0.05%, 
±0.005 dB

±0.006%,
0.3 mV

未校准，最大值

(–40 °C ～ 70 °C)
1.9%, 

±0.16 dB
±0.27%, 
13.9 mV

未校准，常规值
(25 °C ±5 °C)

0.48%, 
±0.04 dB

±0.04%,
2.3 mV

* 量程 = 5.1 Vpk
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通带

频率 ............................................................ 0.45 · fs

平坦度 (fs = 51.2 kS/s) ......................... ±40 mdB （峰峰值，最大值）

相位非线性

(fs = 51.2 kS/s) ....................................... ±0.45°，最大值

阻带

频率 ............................................................ 0.55 · fs

抑制 ............................................................ 100 dB

无混叠带宽 ........................................................ 0.45 · fs

过采样率 ............................................................ 64 · fs

串扰 (1 kHz) .....................................................  –110 dB

CMRR (fin ≤ 1 kHz)

最小值 ........................................................ 40 dB
常规值 ........................................................ 47 dB

SFDR (fin = 1 kHz, –60 dBFS)..................... 120 dB

空闲通道噪声和噪声密度

输入阻抗

差分 ............................................................ 305 kΩ
AI– （屏蔽）－机箱地 .......................... 50 Ω

总谐波失真 (THD)

互调失真 (–1 dBFS)
DIN 250 Hz/8 kHz
4:1 幅值比.................................................  –80 dB
CCIF 11 kHz/12 kHz
1:1 幅值比.................................................  –93 dB

空闲通道 51.2 kS/s 25.6 kS/s 2.048 kS/s

噪声 97 dBFS 99 dBFS 103 dBFS

50 µVrms 40 µVrms 25 µVrms

噪声密度 310 nV/ √ Hz 350 nV/ √ Hz 780 nV/ √ Hz

输入幅值

1 kHz, 
–40 °C ～ 70 °C

8 kHz, 
–40 °C ～ 70 °C

–1 dBFS –95 dB –87 dB

–20 dBFS –95 dB –80 dB
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电源要求
USB 电流消耗.................................................... 500 mA，最大值

暂停模式 .................................................... 2.5 mA，最大值

总线接口
USB 规范 ............................................................USB 2.0 高速

物理特性
尺寸...................................................................... 12.1 cm × 8.6 cm × 2.5 cm 

(4.75 in. × 3.37 in. × 0.99 in.)

重量......................................................................  约 250 g (8.8 oz)

安全性
请使用干毛巾清洁模块。

安全电压
仅连接规定范围之内的电压。

通道－地............................................................. ±30 V 最大值，
Measurement Category I

隔离

通道间隔离................................................  无

通道－地隔离 ...........................................  无

Measurement Category I 是指测量与配电系统非直接相连 （MAINS 电

压）的电路。 MAINS 是对设备供电的危险电源。 该类别用于测量受特殊保

护的二级电路的电压。 这类电压测量包括对信号电平、特殊设备、设备能量

有限制的部件、由低压源供电的电路，以及电子设备的测量。

注意 在 Measurement Categories II、 III 和 IV 中，请勿使用 NI USB-9234 连接信号或

进行测量。

安全标准
该产品设计符合以下测量、控制和实验室用途的电气设备安全标准：

• IEC 61010-1, EN-61010-1

• UL 61010-1, CSA 61010-1

注 关于 UL 和其他安全认证信息，请查看产品标签或访问 ni.com/certification，
通过模块编号或产品类型搜索，并在 “ 认证 ” 栏中查看相应链接。
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危险环境
NI USB-9234 未通过用于危险环境的认证。

环境
NI USB-9234 设备只适用于室内。

运行环境温度.................................................... 0 °C ～ 60 °C 

存储温度 ............................................................  –40 °C ～ 85 °C

防护等级 ............................................................ IP 40

运行环境湿度 (IEC 60068-2-56)................ 10% ～ 90% RH，无凝结 

存储湿度 (IEC 6008-2-56) ........................... 5% ～ 95% RH，无凝结

最高海拔 ............................................................ 2000 m 

污染等级 (IEC 60664)................................... 2

电磁兼容性
产品设计符合以下测量、控制和实验室用途的 EMC 标准：

• EN 61326 EMC ；最小抗扰度

• EN 55011 放射标准； Group 1 （非蓄意放射）， Class A （不使用于

住宅区）

• CE, C-Tick, ICES 和 FCC Part 15 放射标准； Class A

注 依据 EMC 规范，设备应使用屏蔽式线缆。

CE 合规声明
产品已达到现行欧盟产品规范的基本要求，并附有 CE 标志。如下所示：

• 2006/95/EC ；低电压规范 （安全性）

• 2004/108/EC ；电磁兼容标准 (EMC)

注 关于合规信息，见产品的合规声明 (DoC)。 请访问 ni.com/certification，通过

模块编号或产品类型搜索，并在 “ 认证 ” 栏中点击相应链接，获取本产品的合规声明。

环境保护
NI 始终致力于设计和制造有助于环境保护的产品。 NI 认为减少产品中的有

害物质不仅有益于环境，也有利于 NI 客户。

关于环境保护的详细信息，请登录 ni.com/environment，查看 NI and 
the Environment 页面。 该页包含 NI 遵守的环境准则和规范，以及其他本

文档未包括的环境信息。
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电子电器设备废弃物 (WEEE)
欧盟用户  超过生命周期的所有产品都必须送到 WEEE 回收中心。 关于 WEEE 回收中心及

NI WEEE 项目，请访问 ni.com/environment/weee.htm。

校准
访问 ni.com/calibration可获取与 NI USB-9234 校准服务相关的校准认

证和信息。

校准周期............................................................. 1 年

技术支持

NI 网站可提供全面的技术支持资源。 访问 ni.com/support，您可获取疑

难解答、应用程序开发自助资源，以及来自 NI 应用工程师的电话或电子邮

件帮助。

NI 总部地址：11500 North Mopac Expressway, Austin, Texas, 
78759-3504。 NI 在全球设立的分支机构也将为您提供技术支持。 在美国，

可访问 ni.com/support提交服务请求并按要求进行操作，或拨打电话

512 795 8248 获取技术支持。在其他国家或地区，可联系当地办事处获取

技术支持： 

澳大利亚 1800 300 800，奥地利 43 662 457990-0，
比利时 32(0) 2 757 0020，巴西 55 11 3262 3599，加拿大 800 433 3488，
中国 86 215050 9800，捷克共和国 420 224 235 774，
丹麦 45 45 76 26 00，芬兰 385 (0) 9 725 725 11，
法国 33 (0) 1 48 14 24 24，德国 490 89 741 31 30，
印度 91 80 41190000，以色列 972 (0) 3 6393737，
意大利 39 02 413091，日本 0120-5472 2970，韩国 82 02 3451 3400，
黎巴嫩 961 (0) 1 33 28 28，马来西亚 1800 887710，
墨西哥 01 800 010 0793，荷兰 31 0 348 433 466，新西兰 0800 553 322，
挪威 47 (0) 66 90 76 60，波兰 48 22 3390150，葡萄牙 351 210 311 210，
俄罗斯 7 495 783 68 51，新加坡 1800 226 5886，
斯洛文尼亚 386 3 425 42 00，南非 27 0 11 805 8197，
西班牙 34 91 640 0085，瑞典 46 (0) 8 587 895 00，
瑞士 41 56 200 51 51，台湾 886 02 2377 2222，泰国 662 278 6777，
英国 44 (0) 1635 523545

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)



 

CVI, LabVIEW, National Instruments, NI, ni.com, National Instruments 公司标识，以及鹰形标
识均为 National Instruments Corporation 的商标。关于其它 National Instruments 商标，请访
问 ni.com/trademarks参考 Trademark Information。The mark LabWindows is used under 
a license from Microsoft Corporation. Windows is a registered trademark of Microsoft 
Corporation in the United States and other countries. 此处提及的其它产品和公司名称为其各
自公司的商标或商业名称。关于 National Instruments 产品和技术的专利权，见软件中的帮助 »专
利信息、光盘上的 patents.txt文档，或登录 ni.com/patents查看 National Instruments 
Patent Notice。关于 National Instruments 全球贸易合规性政策，以及如何获取 HTS 编码、
ECCN 和其他进出口数据的详细信息，请参考 ni.com/legal/export-compliance的 Export 
Compliance Information。
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